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Fonctionnalités de votre 
nouveau lecteur MP4
Elégant, intelligent, fi able et très pratique : votre nouveau lecteur MP4 est tout 
cela à la fois et plus encore ! Sa technologie de pointe offre une qualité de son 
et d’image exceptionnelle. Vous ne pourrez plus vous passer de votre nouveau 
lecteur MP4, que ce soit pour pratiquer une activité physique, télécharger vos 
chansons préférées, regarder des vidéos ou même écouter la radio FM.
Utilisez-le ne serait-ce qu’une seule fois et vous vous demanderez comment 
vous avez pu vivre sans !
TOTALEMENT MULTIMEDIA
Nous l’appelons lecteur MP4 mais c’est bien 
plus qu’un simple lecteur. Il permet d’affi cher des 
images, du texte, des vidéos et même d’écouter 
la radio FM.

TOUCHE UTILISATEUR POUR UN CONTRÔLE 
INSTANTANÉ
Vous pouvez accéder à cette fonction 
directement via la touche utilisateur dans chaque 
mode séparément.

ECRAN COULEUR LCD
Des images aux couleurs vives peuvent être 
affi chées sur l’écran large LCD.

CARTE MICROSD EXTERNE
Le logement de la carte microSD intégré vous 
permet de profi ter de vos photos et fi chiers 
musicaux sur un périphérique externe, tel qu’un 
téléphone mobile ou une caméra numérique.

ECOUTE PROLONGEE ET DUREE DE 
TELECHARGEMENT REDUITE !
Une batterie entièrement chargée permet de lire 
jusqu’à 22 heures de musique et 4 heures de 
vidéo.
La durée de téléchargement a en outre été 
sensiblement réduite. Grâce au standard USB 
2.0, le lecteur est bien plus rapide que les 
modèles utilisant le format USB 1.1.

UNE QUALITE D’ECOUTE EXCEPTIONNELLE
Votre nouveau lecteur MP4 intègre la technologie 
sonore exclusive DNSe™ (Digital Natural Sound 
engine) de Samsung, fonction permettant de 
fournir un son d’une pureté et d’une richesse 
incroyables pour un plaisir d’écoute inégalé.



Consignes de sécurité
Signifi cation des icônes et symboles utilisés dans ce 
manuel d’utilisation :

AVERTISSEMENT
Indique un risque de blessure grave, voire mortelle.

ATTENTION
Indique un risque potentiel de blessure ou de dégât matériel.

ATTENTION

Pour diminuer les risques d’incendie, d’explosion, de décharge 
électrique ou de blessure lorsque vous utilisez le lecteur MP4, 
respectez les consignes de sécurité indiquées.

REMARQUE

Indique des conseils ou des pages auxquelles se référer afi n 
d’en savoir plus sur le fonctionnement du lecteur.

NE PAS tenter d’effectuer quoi que ce soit.

NE PAS démonter.

NE PAS toucher.

Respecter scrupuleusement les consignes.

Débrancher la fi che de la prise murale.

Appeler le service d’assistance technique pour obtenir de l’aide.

Ces symboles d’avertissement vous indiquent comment éviter de vous blesser 
et de blesser d’autres personnes. 
Veuillez respecter scrupuleusement les consignes. 
Après avoir lu ce chapitre, rangez ce mode d’emploi précieusement afi n de 
pouvoir vous y référer ultérieurement.



Consignes de sécurité
Ce manuel vous indique comment utiliser correctement votre nouveau 
lecteur MP4. Lisez-le attentivement avant toute utilisation afi n d’éviter 
d’endommager votre lecteur ou de vous blesser.
Portez particulièrement attention aux avertissements suivants :

PROTEGEZ-VOUS
Ne prenez pas l’initiative de démonter, réparer ou modifi er cet appareil vous-
même.
Evitez de mouiller l’appareil ou de le faire tomber dans l’eau. Si une telle situation 
se produit malgré tout, n’allumez pas le lecteur, car vous risqueriez de vous 
électrocuter. Contactez plutôt le service clientèle de Samsung le plus proche de 
chez vous.
N’utilisez pas ce produit en cas d’orage et de foudre. Vous vous exposeriez à un 
risque de dysfonctionnement ou de décharge électrique.
N'utilisez pas les écouteurs lorsque vous conduisez une bicyclette, une 
automobile ou une moto.
Dans le cas contraire, vous risqueriez de provoquer un accident grave.
L’utilisation des écouteurs en marchant ou lorsque vous courrez, en particulier sur 
les passages piétons, peut se révéler très dangereuse.
Pour votre sécurité, veillez à ne pas laisser le cordon des écouteurs gêner vos 
mouvements de bras ou d’autres objets avoisinants.
Ne conservez pas l’appareil dans un endroit humide, poussiéreux ou couvert de 
suie ; vous risqueriez de provoquer un incendie ou une décharge électrique.

ATTENTION

AVERTISSEMENT

ATTENTION



PROTEGEZ-VOUS
L’utilisation prolongée des écouteurs ou du casque peut fortement réduire votre 
acuité auditive.
Si vous vous exposez à un volume sonore supérieur à 85 dB pendant une durée prolongée, 
votre ouïe sera irrémédiablement endommagée. Plus le son est élevé, plus votre acuité 
auditive diminue (le niveau sonore d’une conversation ordinaire est compris entre 50 et 60 dB 
alors que celui provenant d’une route est d’environ 80 dB). 
Il est fortement recommandé d’utiliser un volume sonore moyen (le volume moyen est 
habituellement inférieur de 2/3 au volume maximal).
Si vous ressentez des bourdonnements dans les oreilles, réduisez le volume ou 
n’utilisez plus les écouteurs ou le casque.
La batterie ne doit pas être exposée aux sources de chaleur, comme par exemple 
les rayons du soleil ou les fl ammes.

PROTEGEZ VOTRE LECTEUR MP4
Ne laissez pas l’appareil dans un lieu où la température excède 35°C (ex. : sauna 
ou voiture en stationnement).
Evitez tout choc brutal (ex. : chute).
Ne posez pas d’objets lourds sur l’appareil.
Empêchez que des particules externes ou de la poussière ne pénètrent dans l’appareil.
Ne posez jamais l’appareil à proximité d’objets émettant des ondes 
électromagnétiques.
Veillez à toujours enregistrer vos données les plus importantes. Samsung ne 
saurait être tenu responsable en cas de pertes de données.
Utilisez uniquement les accessoires fournis ou agréés par Samsung.
Evitez toute projection d’eau sur l’appareil. Ne nettoyez jamais l’appareil à l’aide 
de produits chimiques (ex. : benzène ou diluant) ; vous risqueriez de provoquer 
un incendie ou une décharge électrique ou de détériorer la surface de l’appareil.
Suivez attentivement ces instructions afi n d’éviter de vous blesser ou 
d’endommager le lecteur.
Nous vous conseillons d’imprimer ce mode d’emploi en couleur et de paramétrer 
l’option d’impression « Ajuster à la taille de la page » pour qu’il soit plus agréable à lire.

ATTENTION

REMARQUE

AVERTISSEMENT

ATTENTION
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Fonctions de base
CONTENU
Votre nouveau lecteur MP4 est fourni avec les accessoires présentés 
ci-dessous. Si l’un de ces éléments ne se trouve pas dans le coffret, contactez le 
service clientèle de Samsung.

Lecteur Ecouteurs Câble USB

Il se peut que les accessoires livrés avec votre appareil soient légèrement différents de 
ceux illustrés.
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VOTRE LECTEUR MP4

Ecran

Touche de menu
Appuyez sur cette touche pour affi cher 
le menu.

Touche Alimentation et Verrouillage
Appuyez une fois sur cette touche
pour verrouiller les fonctions liées aux 
touches de l’appareil.
Appuyez une fois sur cette touche
pour déverrouiller les fonctions liées 
aux touches.
Appuyez longuement sur cette touche
pour éteindre/allumer le lecteur.

Touche Déplacement/Navigation/
Lecture/Pause/Sélection

Logement de la carte microSD

Touche Enregistrement et Utilisateur
Appuyez sur cette touche pour accéder au 
mode Touche utilisateur.
Appuyez longuement sur cette touche
pour enregistrer un mémo vocal.

Touche de retour en arrière
Appuyez sur cette touche pour 
revenir à l’écran précédent.
Appuyez longuement sur cette
touche pour accéder à l’écran du 
menu principal
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VOTRE LECTEUR MP4 (Suite)

Touche de réinitialisation
Si un dysfonctionnement du 

lecteur survient, appuyez sur 
la touche de réinitialisation à 

l’aide d’un objet pointu afi n de 
réinitialiser le système.

Emplacement pour cordelette

Port USB

Cache port USB

Ecouteurs
Pour votre confort, les 

lettres L (écouteur gauche) 
et R (écouteur droit) sont 

gravées sur chaque écouteur. 
Le cordon sert également 

d’antenne radio.

Microphone

Connectique 3.5 mm pour 
écouteurs
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REINITIALISATION DU SYSTEME
Si votre lecteur MP4 ne s’allume pas, ne lance pas la lecture ou n’est pas reconnu par 
votre ordinateur lorsque vous le branchez, il est préférable de réinitialiser le système.

Appuyez sur la touche de réinitialisation 
située sur la face arrière de l'appareil à 
l'aide d'un objet pointu, comme une agrafe.

Le système est réinitialisé.
La fonction Reset (Réinitialisation) ne permet 
pas de supprimer les renseignements de durée 
et les données enregistrées dans la mémoire 
intégrée.
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BRANCHEMENT DE L’APPAREIL SUR UN ORDINATEUR
Chargez la batterie avant d’utiliser votre lecteur pour la première fois ou lorsque vous ne 
l’avez pas utilisé pendant une période prolongée.

1. Branchez l’extrémité la plus étroite du câble USB sur le port de connexion USB situé 
au niveau de la partie inférieure du lecteur.

2. Raccordez l’extrémité la plus large du câble USB au port USB ( ) de votre 
ordinateur.

Durée de charge environ 4 heures

La durée de charge totale varie en fonction de votre environnement informatique. 
Si vous rechargez le lecteur via un ordinateur portable, assurez-vous que la batterie du 
portable est entièrement chargée ou que l’ordinateur est lui-même relié à une prise secteur.
La batterie ne se charge pas lorsque l’ordinateur est en mode Veille ou lorsque le câble est 
déconnecté du PC.

Le lecteur ne peut être chargé que via la connexion à l’ordinateur, à l’aide d'un câble USB. 
N’utilisez pas d’adaptateur CA USB séparé qui pourrait ne pas charger la batterie ou 
empêcher le lecteur de fonctionner correctement.

ATTENTION

2

Affi chage à l’écran
<USB connected> (USB connecté)

< > - Chargement

< > - Chargement terminé

1

REMARQUE
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ENTRETIEN DE LA BATTERIE
La batterie durera plus longtemps si vous respectez les consignes d’entretien et de 
rangement du lecteur.
• Rechargez la batterie dans un lieu où la température est comprise entre 5 et 

35 °C.
• Evitez de surcharger la batterie (12 heures au maximum). Charger ou décharger la 

batterie à des fréquences trop rapprochées peut réduire sa durée de vie.
• Comme pour tout autre produit de consommation, la durée de vie de la batterie 

s’amenuise progressivement avec le temps.

La batterie rechargeable intégrée à ce produit ne peut pas être remplacée par l’utilisateur. 
Pour plus d’informations sur son remplacement, contactez votre service clientèle.

MISE EN MARCHE/ARRÊT DE L’APPAREIL
Mise en marche de l’appareil
Maintenez la touche [ ] enfoncée.

Mise en arrêt de l’appareil
Maintenez la touche [ ] enfoncée.

L’appareil s’éteint automatiquement lorsqu’aucune des touches n’est actionnée pendant 
une durée prédéfi nie en mode Pause (Pause). La durée par défaut de <Auto Power Off>
(Extinction auto) est de 1 minute, mais vous pouvez la modifi er. Consultez la page 23 pour 
plus d’informations.

ATTENTION

REMARQUE
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CONTROLE DU VOLUME
Vous pouvez régler le volume en cours de lecture d’un fi chier.

Poussez la touche [ ] vers le haut ou le bas.
La plage de réglage du volume est comprise entre 0 et 30.0.

VERROUILLAGE DES TOUCHES
La fonction Verrouillage permet de désactiver toutes les touches du lecteur MP4 ; 
ainsi, si vous appuyez sur une touche par mégarde au cours d'un exercice physique, par 
exemple, la musique ne sera pas interrompue pour autant.

1. Appuyez sur la touche [ ].

2. Appuyez de nouveau sur la touche [ ] pour 
désactiver la fonction Verrouillage.
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RECHERCHE DE FICHIERS A L’AIDE DU 
« NAVIGATEUR DE FICHIERS »
Recherchez des fi chiers en toute simplicité grâce la fonction <File Browser> (Navigateur
de fi chiers).

1. Sélectionnez l’icône située sur l’écran du menu 
principal.

2. Sélectionnez un dossier pour accéder à la liste des
fi chiers contenus dans ce dossier.

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier démarre.

SUPPRESSION DE FICHIERS A L'AIDE DU 
« NAVIGATEUR DE FICHIERS »
Suivez les étapes 1 à 2 ci-dessus.

3. Sélectionnez le fi chier que vous souhaitez 
supprimer, puis appuyez sur la touche [ ].

4. Sélectionnez <Delete> (Supprimer) <Yes> (Oui).
Le fi chier sélectionné est supprimé.

Le fi chier sélectionné ne peut pas être supprimé en cours de lecture.

Une fois supprimés, les fi chiers ne peuvent plus être récupérés.

REMARQUE

ATTENTION
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MODIFICATION DES PARAMETRES ET DES PREFERENCES
Vous pouvez modifi er les valeurs par défaut pour véritablement personnaliser votre 
lecteur MP4.

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez l’élément souhaité dans la liste des
paramètres.

3. Sélectionnez l’option de réglage de votre choix.

4. Paramétrez les options de votre choix.
[Liste des paramètres]



Fonctions de base _ 19

MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)

Options de réglage du son
Vous pouvez régler l’égaliseur principal, le signal sonore et l’intensité du volume 
sonore.

Master EQ (EG princ.): Vous pouvez optimiser les 
réglages du son. Sélectionnez la fréquence souhaitée 
et son niveau. 
Beep Sound (Signal sonore): Permet d’activer ou 
de désactiver l’émission d’un signal sonore lors des 
opérations effectuées sur l'écran tactile. Sélectionnez 
<Off> (Arrêt) ou <On> (Marche).
Volume Limit (Limitation du volume): Vous pouvez éviter l’apparition de troubles 
auditifs en limitant le volume sonore lors de l'utilisation des écouteurs. L’option <On> 
(Marche) fi xe le niveau maximal du volume à 15. Le niveau maximal du volume 
lorsque la limite est réglée sur <Off> (Arrêt) est de 30. Si vous sélectionnez une valeur 
supérieure à 15, le volume sera réinitialisé à sa valeur par défaut de 15 lorsque vous 
allumez le lecteur afi n de vous éviter tout risque de perte de l’acuité auditive lorsque 
vous rallumerez le lecteur.
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MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)

Options de réglage de l’affi chage
Changez la police, le délai de désactivation de l’affi chage et la luminosité de 
votre écran, etc.

Reset My Skin (Réinitialiser mon habillage): 
Permet de remplacer l’image de fond d’écran par 
l’image par défaut.
Display Off Time (Délai de désactivation de 
l’écran): Si aucune touche n’est actionnée pendant 
la durée défi nie, l’écran s’éteindra automatiquement. 
Pour rallumer l’écran, il vous suffi t d’appuyer sur 
n’importe quelle touche.
Brightness (Luminosité): Permet de régler la luminosité de l’écran d’affi chage. 

Option de réglage de la mise à jour de la bibliothèque 
Si un nom de fi chier s’affi che de manière 
anormale, spécifi ez la langue appropriée puis 
sélectionnez <Library Update> (Mise à jour de la 
Bibliothèque) pour rectifi er le nom du fi chier.
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MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)

Options de réglage de la langue
De nombreuses langues sont disponibles pour l’affi chage des menus 
de votre nouveau lecteur MP4. Vous pouvez changer facilement de 
préférence de langue.

Menu : Permet de régler la langue du menu.
Options disponibles <English>, < >,
<Français>, <Deutsch>, <Italiano>, < >,
< >, < >, <Español>, < >,
<Magyar>, <Nederlands>, <Polski>, <Português>, 
<Svenska>, < >, < eština>, < >,
<Türkçe>, <Norsk>, <Dansk>, <Suomi>, <Español 
(Sudamérica)>, <Português (Brasil)>, <Indonesia>, 
< >, <Român >, < >,
<Slovenš ina> et <Slovenský>.

Contents (Sommaire) : Vous permet de régler la langue 
dans laquelle les informations de suivi et le texte seront 
affi chés. Options disponibles <English>, <Korean>, <French>, <German>, <Italian>, 
<Japanese>, <Chinese(S)>, <Chinese(T)>, <Spanish>, <Russian>, <Hungarian>, 
<Dutch>, <Polish>, <Portuguese>, <Swedish>, <Thai>, <Finnish>, <Danish>, 
<Norwegian>, <Afrikaans>, <Basque>, <Catalan>, <Czech>, <Estonian>, <Greek>, 
<Hrvatski>, <Icelandic>, <Romanian>, <Slovak>, <Slovene> et <Turkish>.

Les langues prises en charge peuvent être modifi ées ou ajoutées.
REMARQUE
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MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)

Options de réglage de l’heure
Ceci vous permet de régler la date/l’heure et le fuseau horaire.

Date&Time (Date et heure): Réglez la date et 
l’heure actuelles. Réglez les options <Year> (Année), 
<Month> (Mois), <Date>, <Hour> (Heure), <Min>, 
<AM/PM>.
Time Zone (Fuseau hr) : Vous pouvez consulter 
l’heure actuelle en sélectionnant le fuseau horaire 
d’une ville internationale spécifi que. Vous devez 
commencer par régler le fuseau horaire pour 
pouvoir affi cher les informations relatives à l’horloge
universelle. Reportez-vous à la page 69.
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MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)

Options de réglage du système
Sélectionnez Sleep Timer (Veille), Auto power off (Extinction auto) et le réglage 
par défaut approprié.

My Info: Vous permet de saisir votre nom et votre 
date de naissance. Reportez-vous à la page 24.
Sleep (Veille): Permet d’éteindre automatiquement 
l’appareil après écoulement de la durée prédéfi nie.
Auto Power Off (Extinction auto): Permet d’éteindre 
automatiquement l’appareil lorsque celui-ci est en 
mode Pause et qu’aucune touche n’est actionnée
avant écoulement de la durée prédéfi nie.
User Button Guide (Guide Touche Utilisateur): Le guide Touche utilisateur correspondant 
aux différents modes s’affi che rapidement dans le coin supérieur droit de l’écran.
Default Set (Réglage par défaut): Permet de revenir aux valeurs de paramètres par 
défaut. <Yes> (Oui) vous permet de rétablir les paramètres par défaut de l’appareil. <No> 
(Non) permet d’annuler les paramètres par défaut.
Format (Formater): Permet de formater la mémoire interne. Sélectionner <Yes> (Oui) 
permet de formater la mémoire interne et de supprimer tous les fi chiers du lecteur. En 
revanche, sélectionner <No> (Non) permet de ne pas lancer le formatage de la mémoire 
interne. Vérifi ez avant de lancer le formatage.
About (A propos de): Permet de consulter la version du micrologiciel, la capacité de la 
mémoire et le numéro de fi chier.
<Firmware Version> (Version du fi rmware) - affi che la version actuelle du micrologiciel.
<Memory> (Mémoire) -  <Used> (Utilisé) indique la mémoire actuellement utilisée, 
<Remaining> (Mémoire restante) indique la capacité restante de la mémoire et <Total> 
indique la capacité totale de la mémoire.
<Files> (Fichiers) - permet de consulter le nombre de fi chiers musicaux, de vidéos, 
d’images, de textes ainsi que le nombre total de fi chiers.

A propos de la mémoire intégrée
1 Go=1,000,000,000 octets : la capacité réelle formatée peut être inférieure, car le 
micrologiciel interne en utilise une partie.

REMARQUE
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MODIFICATION DES PARAMETRES ET DES PREFERENCES (Suite)
Réglage du nom

1. Sélectionnez <My Info> (My Info).

2. Sélectionnez <My Name> (Mon nom).

3. Saisissez votre nom.
[ ] : Permet de passer du mode 

alphanumérique au mode numérique.
[  ] : Permet de supprimer les caractères 

un par un.

[  ] : Permet d’insérer ' – '.

[  ] : Permet de confi rmer votre réglage.
Lorsque le nom a été paramétré, vous devez le voir s’affi cher.

Réglage de votre anniversaire
Avant de démarrer - Vous devez tout d’abord régler l’horloge. 
Reportez-vous à la page 22.

1. Sélectionnez <My Info> (My Info).

2. Sélectionnez <My Birthday> (Mon anniv.).

3. Réglez les options <Year> (Année), 
<Month> (Mois), <Day> (Jour).

4. Appuyez sur la touche [ ].
Une fois que vous avez saisi votre date d’anniversaire, celle-ci vous sera rappelée. 
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EmoDio
EmoDio est une application logicielle fournie avec ce lecteur MP4.
Elle est destinée à prendre en charge divers services de contenus et
différents supports de périphérique.

Avant de démarrer - Suivez les instructions du guide de démarrage rapide pour installer 
EmoDio. Branchez le lecteur sur l’ordinateur.
<EmoDio> démarre automatiquement lorsque vous branchez le lecteur sur votre ordinateur. 
Si le programme ne démarre pas automatiquement, double-cliquez sur l'icône 
<EmoDio> située sur le Bureau.

CONFIGURATION REQUISE
Votre ordinateur doit être conforme à la confi guration minimale requise suivante pour 
que vous puissiez installer et exécuter EmoDio :

• Pentium 500 MHz ou plus

• Port USB 2.0

• Windows 2000/XP/Vista

• DirectX 9.0 ou version ultérieure

• 300 Mo d’espace libre sur le disque dur

• Résolution 1024 X 768 ou plus

• Internet Explorer 6.0 ou version ultérieure

• Mémoire vive 512 Mo ou plus
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UTILISATION D’EMODIO
L’application logicielle EmoDio est facile à utiliser et vous permet de classer vos 
fi chiers sur votre ordinateur. Une fois vos fi chiers classés et organisés dans EmoDio, 
vous pouvez les transférer rapidement vers votre lecteur MP4 sans avoir à faire des 
recherches sur l’ensemble de votre disque dur pour retrouver le bon fi chier.

  Le programme <EmoDio> est le moyen le plus simple de transmettre des fi chiers 
de votre ordinateur vers votre lecteur MP4.

Grâce à <EmoDio>, créez votre propre collection ou liste de lecture ainsi que vos 
fi chiers audio originaux.

Vous pouvez transférer vers le lecteur les informations relatives au blog et les 
fi chiers enregistrés au format RSS.

Il s’agit d’un service communautaire en ligne à l’intention des utilisateurs d’EmoDio.
com. Il offre une méthode simple et facile de charger et télécharger des contenus 
produits à l’aide d’EmoDio et des moyens permettant d’échanger vos expériences 
avec d’autres utilisateurs de la communauté.

Pour plus d’informations sur <EmoDio>, cliquez sur <MENU>  <Help> (Aide)  <Help> 
(Aide) en haut du programme <EmoDio>.REMARQUE
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UTILISATION D’EMODIO (Suite)

Ne débranchez jamais le câble USB durant le transfert de fi chiers ; vous risqueriez 
d’endommager le lecteur ou l’ordinateur.
Branchez le lecteur directement sur l’ordinateur plutôt que sur un Hub USB afi n d’éviter une 
mauvaise connexion.

Toutes les fonctions du lecteur sont désactivées durant la connexion à l’ordinateur.
Utilisez le système de fi chiers FAT 32 pour le formatage du lecteur sur votre ordinateur. Sous 
Windows Vista, cliquez sur « Restore device defaults » (Restaurer les paramètres par défaut 
du périphérique) et formatez-le.
Si vous branchez le câble USB sur l’ordinateur alors que la charge de la batterie du lecteur 
est faible, le lecteur se chargera pendant plusieurs minutes avant d’établir la connexion avec 
l’ordinateur.
La technologie de reconnaissance musicale et les données relatives sont fournies par 
Gracenote et Gracenote CDDB® Music Recognition ServiceSM.
CDDB est une marque déposée de Gracenote. Le logo et le logotype de Gracenote, le logo 
et le logotype Gracenote CDDB et le logo «Powered by Gracenote CDDB» sont des marques 
déposées de Gracenote. Music Recognition Service et MRS sont des marques de service de 
Gracenote.

REMARQUE

ATTENTION



28 _ EmoDio

UTILISATION DU LECTEUR EN TANT QUE DISQUE AMOVIBLE
Vous pouvez utiliser le lecteur comme appareil de stockage de données amovible.

Avant de démarrer - Branchez le lecteur sur l’ordinateur.

1. Ouvrez les fi chiers/dossiers à transférer à partir 
de l’ordinateur.

2. Ouvrez <My Computer> (Poste de travail) 
<CP3> depuis le bureau.

3. Sélectionnez les fi chiers/dossiers que vous 
souhaitez transférer depuis votre ordinateur et 
faites un cliquer-glisser vers le dossier de votre 
choix dans <CP3>.

Les dossiers ou fi chiers sélectionnés sont transférés vers le lecteur.

Le message de transfert des fi chiers s’affi che pendant le téléchargement. La déconnexion du 
câble USB alors que ce message est affi ché peut entraîner le dysfonctionnement du lecteur.
L’ordre dans lequel les fi chiers musicaux s’affi chent sur votre PC peut être différent de l’ordre 
de lecture de l’appareil.
Si vous transférez un fi chier DRM (Gestion des droits numériques) vers le lecteur, celui-ci ne 
pourra pas être lu.
Vous pouvez utiliser la carte microSD, lorsqu’elle est insérée, comme disque amovible, de la 
même manière que ce qui est expliqué ci-dessus. Reportez-vous à la page 71.
Qu’est-ce que le système DRM ?
La technologie et le service Gestion des droits numériques (Digital Rights Management, 
DRM) permettent d’empêcher toute utilisation illégale de données numériques et de protéger 
les détenteurs de droits d’auteur. Les fi chiers DRM sont des fi chiers musicaux équipés d’une 
technologie de protection contre les copies illégales.

REMARQUE

ATTENTION
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DÉBRANCHER L’APPAREIL DE L’ORDINATEUR
Suivez les étapes ci-dessous pour éviter d’endommager le lecteur et les données au 
moment de débrancher l’appareil :

1. Positionnez le curseur de la souris sur l’icône
 de la barre des tâches située en bas à droite 

du bureau et cliquez sur le bouton gauche de la 
souris.

2. Cliquez sur le message <Safely Remove USB 
Mass Storage Device Drive>(Retirer le lecteur 
USB grande capacité en toute sécurité).

3. Vous pouvez à présent débrancher le lecteur de 
l’ordinateur.

Ne débranchez pas le lecteur de l’ordinateur durant le transfert du fi chier. 
Les données ou le lecteur risqueraient d’être endommagés.
Vous ne pouvez pas retirer le lecteur pendant que des fi chiers contenus dans le lecteur sont 
lus sur l’ordinateur. Veuillez réessayer une fois la lecture terminée.

ATTENTION

1

2
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Regarder une vidéo
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

REGARDER UNE VIDÉO

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez un fi chier vidéo à lire.
La lecture du fi chier vidéo sélectionné démarre.

Avant de procéder au transfert du fi chier vidéo vers le lecteur à l’aide de la fonction 
<EmoDio>, le fi chier est tout d’abord converti automatiquement au format SVI. La taille du 
fi chier est également réglée automatiquement.
Pour obtenir plus d’informations à ce sujet, reportez-vous à la section <EmoDio>.

REMARQUE
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AFFICHAGE DE LA LECTURE VIDÉO

1 Témoin carte microSD 7
Affi chage Lecture/Pause/
Recherche

2 Témoin verrouillage 8 Témoin du mode Vidéo

3 Etat de la batterie 9 Nom du fi chier

4 Heure actuelle 10 Durée de lecture actuelle

5 Durée de lecture totale 11 Barre d'état de la lecture

6 Guide Touche utilisateur

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE

11

4

2

38

7

5

9

10

6 1
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TOUCHES POUR COMMANDER LA LECTURE

Poussez cette touche vers la gauche, 3 secondes après le lancement 
du fi chier actuellement sélectionné, pour relancer la lecture en début de 
fi chier.
Poussez cette touche deux fois, 3 secondes après le lancement 
du fi chier actuellement sélectionné, pour lancer la lecture du fi chier 
précédent.
Poussez cette touche vers la gauche et appuyez longuement afi n de 
revenir en arrière dans le fi chier actuellement sélectionné.

Appuyez sur cette touche pour mettre la lecture en pause.
Appuyez sur cette touche pour reprendre la lecture.

Poussez cette touche vers la droite pour lire le fi chier suivant.
Poussez cette touche vers la droite et appuyez longuement afi n 
d’avancer dans le fi chier actuellement sélectionné.

Poussez cette touche vers le haut ou le bas pour respectivement 
augmenter ou diminuer le volume.
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UTILISATION DU MENU VIDÉO

Réglage d'un signet
Ajouter à vos favoris une scène spécifi que vous permet de la regarder à tout 
moment.

1. Appuyez sur la touche [ ] pour affi cher 
la scène de votre choix en cours de lecture
vidéo.

2. Sélectionnez <Add Bookmark>
(Ajouter signet).

La position de lecture/d’arrêt actuelle est défi nie 
comme signet.
Le symbole [ ] apparaît dans la barre de progression de la lecture.

Vous pouvez également défi nir un signet en appuyant sur la touche [ ].
Un signet peut être défi ni pour chaque fi chier vidéo (100 signets au maximum).
La position du signet peut être légèrement différente de la position réelle.

Accéder à un signet/Supprimer un signet

1. Appuyez sur la touche [ ] durant la 
lecture vidéo

2. Sélectionnez <Go to Bookmark> 
(Accéd. à signet) ou <Delete Bookmark>
(Supprimer signet).

Une fois l’option <Go to Bookmark> (Accéd. à 
Signet) sélectionnée, vous accédez au signet sélectionné et la lecture démarre à 
partir de ce signet.
L’option <Delete Bookmark> (Supprimer signet) permet de supprimer le signet 
sélectionné du fi chier vidéo.

REMARQUE
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UTILISATION DU MENU VIDÉO (Suite)

Régler la luminosité
Vous pouvez régler la luminosité de l’écran vidéo.

1. Appuyez sur la touche [ ] durant la 
lecture vidéo

2. Sélectionnez <Brightness> (Luminosité).

3. Sélectionnez la luminosité souhaitée.
Sélectionnez un niveau dans <0-10>.

Le menu de réglage de la luminosité ne peut être réglé qu’à l’écran vidéo.

Pour éteindre l’écran
Par économie d’énergie, vous pouvez éteindre l’écran et vous contenter 
d’écouter le son du fi lm.

1. Appuyez sur la touche [ ] durant la 
lecture vidéo

2. Sélectionnez <Display Off> (Affi ch. 
Désactivé).

L’écran d’affi chage s’éteint.

Pour le rallumer, appuyez sur un bouton 
quelconque.

REMARQUE
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Lecture de fi chiers musicaux
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la 
batterie.

LECTURE PAR CATEGORIE

1. Sélectionnez l’icône  située sur l’écran du menu principal.

2. Sélectionnez l’élément souhaité dans la liste musicale.

3. Sélectionnez un fi chier musical à lire.
La lecture du fi chier musical démarre.
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LECTURE PAR CATEGORIE (Suite)

Liste de fi chiers musicaux
Les informations sur le fi chier comprenant le nom de l’artiste, le nom de l’album, le titre de la plage 
et le genre s’affi chent en fonction des informations fi gurant sur l’étiquette ID3 du fi chier musical 
correspondant. Un fi chier sans étiquette ID3 s’affi che comme [Unknown] (inconnu).

Now Playing (En lecture): Permet de lire le fi chier lu en dernier ou d’affi cher l'écran de lecture du 
fi chier en cours.
Artists (Artiste): Lecture par artiste.
Albums : Lecture par album. Affi che simultanément l’image de la jaquette du CD et le titre de 
l’album.
Songs (Chansons): Lecture en ordre numérique ou alphabétique.
Genres: Lecture par genre.
Playlists (Playlist): Lecture par liste.
Recorded Files (Fichiers Enregistrés): Affi che tous les fi chiers enregistrés.
Music Browser (Navig. musique): Affi che tous les fi chiers musicaux enregistrés dans le dossier 
musical.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives au fi chier 
telles que le titre, l’artiste, l’album, l’année, le genre et un champ commentaire.

REMARQUE
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AFFICHAGE DE LA LECTURE MUSICALE

1 Guide Touche utilisateur 9 Durée de lecture totale

2 Témoin carte microSD 10 Témoin du menu associé

3 Témoin verrouillage 11
Affi chage Lecture/Pause/
Recherche

4 Etat de la batterie 12 Témoin du mode Musique

5 Heure actuelle 13 Témoin du mode Lecture

6 Témoin de lecture de la plage en 
cours/du nombre total de plages 14 Témoin du mode DNSe

7 Ecran Lecteur musical 15 Barre d'état de la lecture

8 Titre de la plage 16 Durée de lecture actuelle

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE
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REMARQUE

TOUCHES POUR COMMANDER LA LECTURE

Poussez cette touche vers la gauche, 3 secondes après le lancement 
du fi chier actuellement sélectionné, pour relancer la lecture en début de 
fi chier.
Poussez cette touche deux fois, 3 secondes après le lancement du fi chier 
actuellement sélectionné, pour lancer la lecture du fi chier précédent. 
Poussez cette touche vers la gauche et appuyez longuement afi n de 
revenir en arrière dans le fi chier actuellement sélectionné.

Appuyez sur cette touche pour mettre la lecture en pause.
Appuyez sur cette touche pour reprendre la lecture.

Poussez cette touche vers la droite pour lire le fi chier suivant.
Poussez cette touche vers la droite et appuyez longuement afi n 
d’avancer dans le fi chier actuellement sélectionné.

Poussez cette touche vers le haut ou le bas pour respectivement 
augmenter ou diminuer le volume.

Dans le cas d’un fi chier VBR, le lecteur peut ne pas fonctionner tel qu’indiqué ci-
dessus, même lorsque vous poussez la touche [ ] vers la gauche.
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RÉPÉTITION D’UN SEGMENT
Cette fonction vous permet d’écouter des parties spécifi ques d’une plage d’une façon 
répétée.Cette option se révèle particulièrement utile lorsque vous apprenez une langue 
par exemple.

1. Appuyez sur la touche [ ] au début de la 
section que vous souhaitez répéter.

Le point de départ est sélectionné et <A > s’affi che.

2. Appuyez à nouveau sur la touche [ ] afi n de 
défi nir la fi n de la section que vous souhaitez répéter.

<A B> s’affi che et le segment spécifi é est lu de façon répétée.

Annuler la répétition

Appuyez à nouveau sur la touche [ ] pendant la répétition du segment.
La répétition du segment est annulée.

La répétition du segment s’annule automatiquement dans le cas suivant :
- Lorsque le début du segment à répéter est défi ni mais que la fi n ne l’est pas avant que la 

plage en cours ne se termine.
- Si le point de fi n est spécifi é sur une durée de lecture inférieure à 3 secondes à compter du 

point de début.

REMARQUE
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CREATION D’UNE LISTE DE LECTURE SUR VOTRE 
LECTEUR MP4
Si vous avez déjà téléchargé des fi chiers sur votre lecteur MP4, vous pouvez créer une 
liste de lecture « Favoris » sans utiliser EmoDio ni votre ordinateur.

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Music Browser> (Navig. musique).

3. Sélectionnez un fi chier à ajouter et appuyez sur la
touche [ ].

4. Sélectionnez <Add to Playlist> (Aj. à liste lect.).

5. Sélectionnez une liste de lecture pour y ajouter le fi chier sélectionné.
Le fi chier sélectionné est ajouté à la liste de lecture.

Vous pouvez ajouter jusqu'à 200 fi chiers musicaux dans chaque liste de lecture.

LECTURE D’UNE LISTE DE LECTURE

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists> (Playlist).

3. Sélectionnez la liste de lecture souhaitée.

4. Sélectionnez un fi chier musical à lire.
La lecture du fi chier musical démarre.

REMARQUE
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SUPPRESSION D’UN FICHIER DE LA LISTE DE LECTURE

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez <Playlists> (Playlist).

3. Sélectionnez la liste de lecture souhaitée.

4. Sélectionnez un fi chier à supprimer et appuyez sur la
touche [ ].

5. Sélectionnez <Delete from Playlist> (Suppr. de liste lect.).
Le fi chier sélectionné est supprimé de la liste de lecture.

SUPPRESSION DE TOUS LES FICHIERS DE LA LISTE DE 
LECTURE
Suivez les étapes 1 à 3 ci-dessus.

4. Appuyez sur la touche [ ].

5. Sélectionnez <Delete All from Playlist> (Suppr. tt de 
liste lect.).

Tous les fi chiers sont supprimés de la liste de lecture.

Le fi chier sélectionné dans la liste de lecture ne peut pas être supprimé en cours de lecture.
REMARQUE
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UTILISATION DU MENU MUSIQUE
Le menu Musique vous permet de gérer toutes les facettes de l’écoute (de la sélection 
des plages et des playlists au choix du fond d’écran durant l'écoute).

Régler l’effet sonore
Vous pouvez sélectionner l’effet sonore pour vos fi chiers musicaux préférés.

1. Appuyez sur la touche [ ] tout en 
écoutant la musique.

2. Sélectionnez <Sound Effect> (Effets 
Sonores).

3. Sélectionnez un effet sonore de votre choix.

Options d’effet sonore
Street Mode (Mode Rue): Permet d’écouter clairement en extérieur grâce au fi ltrage de 
certains bruits de la rue. Sélectionnez <Off> (Arrêt) ou <On> (Marche).
Clarity (Netteté): Vous bénéfi ciez d’un son plus clair et de meilleure qualité. 
Sélectionnez une valeur de 0 à 2.
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UTILISATION DU MENU MUSIQUE (Suite)

Régler la fonction Digital Natural Sound engine (DNSe)
Vous permet de choisir le type de son convenant le mieux à chaque genre 
musical.

1. Appuyez sur la touche [ ] en cours 
d’écoute.

2. Sélectionnez <DNSe>.

3. Sélectionnez le DNSe souhaité.
Choisissez entre <Normal>, <Studio>, <Rock>, 
<Classical> (Classique), <Jazz>, <Ballad> 
(Ballade), <Club>, <R&B>, <Dance> (Danse), <Concert Hall> (Salle Concert) et 
<User> (Utilisateur).
Vous pouvez régler <EQ> (EG) et <3D&BASS> (3D&BASS) en mode DNSe après 
avoir sélectionné <User> (Utilisateur). Reportez-vous à la page 44.

Qu’est-ce que la fonctionnalité DNSe ?
La technologie Digital Natural Sound Engine (DNSe) est une fonction d’optimisation 
sonore conçue par Samsung pour les lecteurs MP4. Cette option offre différents 
réglages sonores visant à améliorer le type de musique que vous écoutez.

REMARQUE
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UTILISATION DU MENU MUSIQUE (Suite)

Pour sélectionner l’élément DNSe utilisateur

1. Appuyez sur la touche [ ] tout en 
écoutant la musique.

2. Sélectionnez <DNSe> <User> (Utilisateur).
Vous pouvez régler les options DNSe utilisateur.

3. Réglez les options souhaitées et appuyez sur 
la touche [ ].

L’élément DNSe utilisateur défi ni est sélectionné.

Options DNSe utilisateur
Vous pouvez régler les options <EQ> (EG) et <3D&Bass> (3D & BASS) lorsque 
vous avez sélectionné <User> (Utilisateur).

EQ (EG): Vous pouvez paramétrer les fréquences sonores individuellement selon vos 
préférences.Vous pouvez régler le niveau de fréquence sur une valeur comprise entre 
–10 et +10.
3D&Bass (3D & BASS): Permet de régler l'effet sonore 3D et le renforcement des 
basses. Les fonctions <3D> (3D) et <Bass> (Basse) disposent de plusieurs niveaux (0 à 
4) que vous pouvez choisir à votre guise.
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UTILISATION DU MENU MUSIQUE (Suite)

Régler le mode de lecture
Sélectionnez le mode de lecture parmi les options ci-dessous.

1. Appuyez sur la touche [ ] en cours 
d’écoute.

2. Sélectionnez <Play Mode> (Mode lecture).

3. Sélectionnez un mode de lecture de votre 
choix.

Options du mode de lecture
Normal: Permet de lire une fois tous les fi chiers de la liste musicale actuelle dans l’ordre.
Repeat (Répéter): Permet de répéter la lecture de tous les fi chiers de la liste musicale 
actuelle.
Repeat One (Répéter 1X): Permet de répéter la lecture d’un fi chier.
Shuffl e (Aléatoire): Permet de répéter la lecture de tous les fi chiers de la liste musicale 
actuelle de manière aléatoire.
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UTILISATION DU MENU MUSIQUE (Suite)

Sélectionner l’écran de lecture musicale
Choisissez une image comme fond d’écran parmi les images disponibles
pendant que vous écoutez la musique.

1. Appuyez sur la touche [ ] en cours 
d’écoute.

2. Sélectionnez <Music Play Screen>
(Ecran Lect mus.).

3. Sélectionnez l’écran de lecture musicale de 
votre choix.

Options de l’écran de lecture musicale
Choisissez entre <Album Art> (Image CD), <Album Info.> (Info.album), <Spectrum> 
(Spectre), <Passionate> (Passion), <Sweet> (Doux) et <Cheerful> (Joie).
Album Art (Image CD): L’image de la jaquette du CD s'affi che si une image de jaquette 
fi gure dans les informations de l’étiquette ID3 du fi chier musical.
Seules les images de la jaquette du CD de taille inférieure à 2 Mo sont prises en charge.
Album Info. (Info.album): Les informations concernant le nom de l’artiste, l’album et le 
genre s’affi chent si celles de l’étiquette ID3 sont enregistrées dans le fi chier musical.

Qu’est-ce que l’étiquette ID3 ?
Il s’agit d’un élément attaché à un fi chier MP3 contenant les informations relatives 
au fi chier telles que le titre, l’artiste, l’album, l’année, le genre et un champ 
commentaire.

REMARQUE



Visualisation des images _ 47

Visualisation des images
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

VISUALISATION DES IMAGES

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez le fi chier image souhaité.
L’image sélectionnée s'affi che.

Accéder à l’image précédente/suivante

En mode Affi chage, poussez sur la touche [ ] vers la gauche ou la droite.
L’image précédente/suivante s'affi che.

[ ] s’affi chera si les fi chiers image comportent des informations erronées sur les vignettes.
Le chargement de certaines images peut être lent.
Avant le transfert du fi chier image vers le lecteur à l'aide du logiciel <EmoDio>, celui-ci est 
tout d’abord converti automatiquement au format JPG. La taille du fi chier est également 
réglée automatiquement. Pour obtenir plus d’informations à ce sujet, reportez-vous à 
<EmoDio>.

REMARQUE
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AFFICHAGE DES IMAGES

1 Témoin verrouillage 6 Témoin carte microSD

2 Heure actuelle 7
Etat de la lecture des fi chiers 
musicaux

3 Etat de la batterie 8 Témoin du mode Image

4
Témoin du fi chier en cours/du 
nombre total de fi chiers 9 Témoin du menu racine

5 Images au format vignette 10 Icône de diaporama

Les représentations à l’écran fi gurent à titre indicatif uniquement. 
L’écran réel de votre appareil peut être différent.REMARQUE
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UTILISATION DU MENU IMAGE

Pour utiliser le mini-lecteur
Vous pouvez lire le fi chier musical de votre choix tout en visionnant une photo.

Appuyez sur la touche [ ] tout en visionnant 
une image.

Le mini-lecteur s’affi che.

Vous pouvez utiliser la touche [ ] pour mettre la 
lecture en pause ou passer au fi chier précédent ou 
suivant.

Le mini-lecteur ne s’affi chera que si vous visionnez une photo en cours de lecture 
musicale ou de pause.REMARQUE
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UTILISATION DU MENU IMAGE (Suite)

Affi cher un diaporama

1. Appuyez sur la touche [ ] en cours de 
visionnage.

2. Sélectionnez <Start Slideshow> 
(Démarrer diaporama).

Le symbole [ ] s’affi che à l’écran et le lecteur 
démarre le diaporama.

Arrêter un diaporama

1. Appuyez sur la touche [ ] en mode 
diaporama.

2. Sélectionnez <Stop Slideshow> (Arrêt 
diaporama).

Le diaporama s'arrête.

Vous pouvez également arrêter un diaporama en 
appuyant sur la touche [ ] en mode diaporama.

Régler la vitesse du diaporama

1. Appuyez sur la touche [ ] tout en 
visionnant une image.

2. Sélectionnez <Slideshow Speed> 
(Vitesse diaporama).

3. Sélectionnez la vitesse souhaitée.
Choisissez entre <Fast> (Rapide), <Normal> et <Slow> (Lent).

REMARQUE
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UTILISATION DU MENU IMAGE (Suite)

Agrandir une image
Vous pouvez zoomer sur une image.

1. Appuyez sur la touche [ ] tout en 
visionnant une image.

2. Sélectionnez <Zoom>.

3. Sélectionnez le niveau de zoom souhaité.
Choisissez entre <100%>, <200%> et <400%>.

4. Utilisez la touche [ ] pour accéder à la partie de l’image que vous 
souhaitez agrandir.

Annuler le zoom

Appuyez sur la touche [ ] tout en effectuant un zoom sur image.

En mode Affi chage, appuyez sur la touche [ ] pour agrandir l’image.
À chaque fois que vous appuyez sur cette touche, le facteur de zoom change, 
selon la séquence <200%>  <400%>  <100%>.

Plus la taille d’une image est grande, plus long est le temps requis pour en 
effectuer un zoom.

Les options <Zoom>, <Rotate> (Pivoter) et <View Mode> (Mode Affi chage) sont 
désactivées dans le cas d’un fi chier GIF.

REMARQUE
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UTILISATION DU MENU IMAGE (Suite)

Pour faire pivoter une image
Vous pouvez faire pivoter l’image selon vos envies.

1. Appuyez sur la touche [ ] tout en 
visionnant une image.

2. Sélectionnez <Rotate> (Pivoter).

3. Sélectionnez l’angle de votre choix.
Choisissez entre <Left 90°> (Gauch 90°), 
<Right 90°> (90° droite) et <180°>.

Sélection du mode Affi chage image
Vous pouvez affi cher une image horizontalement ou verticalement.

1. Appuyez sur la touche [ ] tout en 
visionnant une image.

2. Sélectionnez <View Mode> (Mode Affi chage).

3. Sélectionnez le mode souhaité.
Sélectionnez <Auto>, <Horizontal> (Horizontal) ou 
<Vertical> (Vertical).
Si vous sélectionnez <Auto>, une image élargie en largeur plus qu’en hauteur 
s’affi chera verticalement et une image agrandie en hauteur plus qu’en largeur 
apparaîtra à l’horizontale.
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UTILISATION DU MENU IMAGE (Suite)

Sélectionner une image comme fond d’écran
Vous pouvez défi nir l’image de votre choix comme fond d’écran.

1. Sélectionnez le fi chier image à défi nir comme 
image de fond d’écran et appuyez sur le 
bouton [ ].

2. Sélectionnez <Select as My Skin> (Sél. 
comme habillage) <Yes> (Oui).

L'image sélectionnée est défi nie comme fond 
d'écran.
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Lecture de texte
Qu’il s’agisse d’un roman, d’un nouveau scénario ou d’un article de 
recherche, votre lecteur MP4 vous permet de lire un document tout en 
écoutant de la musique !

Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.  
Réglez la langue du texte dans <Settings> (Paramètres)  <Language> (Langue) 
<Contents> (Sommaire). Reportez-vous à la page 21.

LECTURE DE TEXTE
1. Sélectionnez l’icône  située sur l’écran du menu 

principal.

2. Sélectionnez le fi chier texte souhaité.
Le texte s'affi che à l'écran.

Appuyez longuement sur la touche [ ] pour affi cher le 
texte en mode plein écran.
Pour retourner sur l’écran précédent, appuyez longuement sur la touche [ ] à nouveau.

Accéder à la page précédente/suivante

Poussez la touche [ ] vers la gauche ou la droite.
Poussez la touche [ ] longuement vers la gauche ou la droite pour accéder à la 
page précédente/suivante.

Votre lecteur MP4 prend en charge les fi chiers au format TXT en mode Texte.
REMARQUE
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UTILISATION DU MENU TEXTE

Pour utiliser le mini-lecteur
Vous pouvez lire un fi chier musical de votre choix tout en affi chant du texte.

Appuyez sur la touche [ ] tout en visionnant 
du texte.

Le mini-lecteur s’affi che.

Vous pouvez utiliser la touche [ ] pour mettre la 
lecture en pause ou passer au fi chier précédent ou 
suivant.

Le mini-lecteur ne s’affi chera que si vous visionnez un texte en cours de lecture 
musicale ou en mode pause.

Accéder à la première page
Utilisez cette fonction pour affi cher le texte de la première page.

1. Appuyez sur la touche [ ] tout en 
visionnant du texte.

2. Sélectionnez <Go to 1st Page> (Aller à la 
1ère page) <Yes> (Oui).

Permet d’accéder à la première page.

REMARQUE
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UTILISATION DU MENU TEXTE (Suite)

Réglage d'un signet
Défi nissez un signet pour revenir à tout moment à ce point du texte.

1. Appuyez sur la touche [ ] sur la page 
souhaitée pendant le visionnage d’un texte.

2. Sélectionnez <Add Bookmark>
(Ajouter signet).

L’écran du texte actuel est associé à un signet et 
le symbole [ ] s’affi che dans le coin supérieur 
gauche de l’écran.

Un signet peut être défi ni pour chaque fi chier texte (100 signets au maximum).

Accéder à un signet/Supprimer un signet

1. Appuyez sur la touche [ ] tout en 
visionnant du texte.

2. Sélectionnez <Go to Bookmark> (Accéd. à 
signet) ou <Delete Bookmark> (Supprimer 
signet).

Vous accédez au signet sélectionné lorsque vous 
cliquez sur <Go to Bookmark> (Accéd. à signet) 
et vous le supprimez du fi chier texte lorsque vous sélectionnez <Delete Bookmark> 
(Supprimer signet).

REMARQUE
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UTILISATION DU MENU TEXTE (Suite)

Réglage du type de visionneuse de texte
Choisissez le type d’affi chage de texte souhaité.

1. Appuyez sur la touche [ ] tout en 
visionnant du texte.

2. Sélectionnez <Text Viewer Type> (Type 
Visionneuse de texte).

3. Sélectionnez le type de visionneuse de texte 
souhaité.

Sélectionnez l’une des options comprises entre <Type 1> et <Type 6>.

Vous pouvez également modifi er le type de visionneuse de texte en appuyant sur la
touche [ ].REMARQUE
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Ecouter la radio FM
Avant de démarrer - Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

ECOUTER LA RADIO FM

Sélectionnez l’icône  située sur l’écran du menu 
principal.

La réception de la radio FM est activée.

Pour utiliser la fonction mute (silence)

Appuyez sur la touche [ ] tout en écoutant la radio FM.

Appuyez à nouveau sur la touche [ ] pour reprendre l’écoute.

Branchez toujours vos écouteurs sur le lecteur lorsque vous recherchez ou réglez des 
fréquences.
Les écouteurs sont utilisés comme antenne de réception des ondes FM.
Dans les zones où la qualité de réception est mauvaise, il se peut que le lecteur ne détecte 
aucune fréquence FM. 

REMARQUE
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AFFICHAGE DE LA RADIO FM

1 Témoin carte microSD 6
Témoin de la fonction Mute 
(Silence)

2 Témoin verrouillage 7 Guide Touche Utilisateur

3 Etat de la batterie 8 Témoin du mode Radio

4 Heure actuelle 9 Témoin de la barre de fréquence 
radio

5
Témoin Manuel/Mode 
Présélection 10

Affi chage de la fréquence 
en cours (MHz)

Les représentations à l’écran fi gurent à titre indicatif uniquement. L’écran réel de votre 
appareil peut être différent.REMARQUE
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RECHERCHER DES STATIONS DE RADIO FM

Poussez longuement la touche [ ] vers la gauche 
ou la droite puis relâchez-la en mode Manuel.

La recherche s’arrête sur la fréquence la plus proche du point 
de relâchement de la touche.

OU,

Poussez la touche [ ] vers la gauche ou la droite pour faire défi ler les fréquences 
une par une, en mode Manuel.

Permet de changer de fréquence à chaque fois que vous faites glisser la touche.
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UTILISATION DU MENU DE LA RADIO FM

Pour basculer vers le Mode présélection
Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos 
présélections FM.

1. Appuyez sur la touche [ ] en mode 
Manuel.

2. Sélectionnez <Go to Preset Mode>
(Aller au mode pré-progr).

Pour basculer vers le Mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle 
d’une fréquence sur la bande FM.

1. Appuyez sur la touche [ ] en mode 
Présélection.

2. Sélectionnez <Go to Manual Mode>
(Aller au mode manuel).
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour mémoriser des stations
Vous pouvez stocker jusqu’à 30 stations dans la mémoire de votre lecteur MP4 
et y accéder en appuyant sur un simple bouton.

Manuel : sélectionnez uniquement les stations que vous souhaitez enregistrer

1. Sélectionnez une fréquence pour effectuer le 
préréglage en mode Manuel, puis appuyez 
sur la touche [ ].

2. Sélectionnez <Add to Preset> (Ajouter aux 
présél.).

La fréquence sélectionnée est ajoutée à la liste de 
présélections.

Vous pouvez également ajouter une fréquence à la liste Présélection en appuyant 
sur la touche [ ].

Automatique : enregistrez automatiquement toutes les stations captées par 
le lecteur

1. Appuyez sur la touche [ ] en mode Radio 
FM.

2. Sélectionnez <Auto Preset> (Présélection 
auto) <Yes> (Oui)

Pour annuler la présélection automatique

Si vous souhaitez annuler la présélection auto, appuyez sur la touche [ ].
La présélection automatique est annulée et seules les fréquences réglées jusque-là 
sont enregistrées.

REMARQUE



Ecouter la radio FM _ 63

UTILISATION DU MENU DE LA RADIO FM (Suite)

Pour écouter une station présélectionnée
Poussez la touche [ ] vers la gauche ou la 
droite en mode Présélection.

Vous pouvez écouter la fréquence radio 
enregistrée.

Pour supprimer une présélection
Suivez les étapes suivantes pour supprimer les fréquences tout en écoutant la 
radio FM.

1. En mode Présélection, recherchez une 
fréquence présélectionnée à supprimer, puis 
appuyez sur le bouton [ ].

2. Sélectionnez <Delete from Preset>
(Suppr. du prérégl.)

La fréquence sélectionnée est supprimée.
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Réglage de la réception FM
Pour recevoir plus ou moins de fréquences radio FM, paramétrez la 
fonction <FM Reception> (Réception FM).

1. Appuyez sur la touche [ ] en mode Radio 
FM.

2. Sélectionnez <FM Reception> (Réception 
FM).

3. Sélectionnez la réception souhaitée.
Choisissez entre <High> (Haut), <Middle> (Milieu) 
et <Low> (Bas).
Le réglage <High> (Haut) vous permet de recevoir le plus grand nombre de 
fréquences.
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UTILISATION DU MENU DE LA RADIO FM (Suite)

Réglage de la région FM
Vous avez la possibilité de modifi er le réglage FM en prévision d’un voyage à 
l’étranger.

1. Appuyez sur la touche [ ] en mode Radio 
FM.

2. Sélectionnez <FM Region> (Région Radio).

3. Sélectionnez la région FM souhaitée. 
Bande de fréquences par région 

Worldwide 
(Monde)

Recherchez des fréquences FM comprises entre 
87,50 MHz et 108,00 MHz par paliers de 50 kHz.

China Recherchez des fréquences FM comprises entre 
76,00 MHz et 108,00 MHz par paliers de 50 kHz.

USA Recherchez des fréquences FM comprises entre 
87,5 MHz et 108,0 MHz pour les lecteurs de 100 
kHz.Korea (Corée)

Japan (Japon)
Recherchez des fréquences FM comprises entre 
76,0 MHz et 108,0 MHz pour les lecteurs de 100 
kHz.

4. Sélectionnez <Yes> (Oui).

Les fréquences radio que vous avez enregistrées précédemment seront 
supprimées si vous modifi ez le réglage <FM Region> (Région FM) de votre lecteur.
La région FM peut être supprimée ou modifi ée en fonction de la région cible du 
lecteur.

REMARQUE
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Affi chage des diffusions 
de donnees
Vous pouvez recevoir automatiquement les informations mises à jour sans 
avoir à vous rendre sur les sites d’actualités, les blogs ou les UCC

Avant de démarrer - Transfert de l’élément de chaîne souhaité vers le lecteur avec 
<EmoDio>. Branchez les écouteurs, puis allumez le lecteur et vérifi ez la batterie.

AFFICHAGE DES DIFFUSIONS DE DONNEES
Vous pouvez affi cher les éléments de chaîne ajoutés à 
<Datacasts> (Dif. donn.).

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez un titre du canal de votre choix.

Icône  : Fichier musical
Icône  : Fichier vidéo
Icône  : Fichier image
Icône  : Fichier texte

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier sélectionné démarre.

Reportez-vous à <Datacasts> (Dif. donn.) dans <EmoDio> pour obtenir des instructions 
détaillées.REMARQUE
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Enregistrement vocal
Pour effectuer un enregistrement vocal.

MÉMO VOCAL

Créer un enregistrement vocal

1. Sélectionnez l’icône  située sur l’écran 
du menu principal.

2. Appuyez sur la touche [ ].
Le lecteur démarre l’enregistrement.

Ne tenez pas le microphone trop près ou trop éloigné de votre bouche, car cela 
pourrait affecter la qualité de l’enregistrement.
L’enregistrement vocal n’est pas optimal lorsque la batterie est trop faible.

Vous pouvez également effectuer l’enregistrement en appuyant longuement sur la
touche [ ].

REMARQUE
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ENREGISTREMENT VOCAL (Suite)

Arrêter l’enregistrement vocal

1. Appuyez sur la touche [ ] pendant 
l’enregistrement.

Un message apparaît vous demandant si vous 
souhaitez écouter le fi chier que vous venez 
d’enregistrer.

2. Sélectionnez <Yes> (Oui) ou <No> (Non).
Sélectionner <Yes> (Oui) vous permet de lire le fi chier que vous venez d’enregistrer.
Sélectionner <No> (Non) vous permet de ne pas lire le fi chier enregistré.

Le fi chier enregistré est sauvegardé au format MP3.
Le fi chier est enregistré à l’emplacement suivant : <File Browser> 
(Dossier Navigateur)  <Recorded Files> (Fichiers Enregistrés)  <Voice> 
(Voix).
La durée maximale d’un fi chier d’enregistrement est de 8 heures.
Vous pouvez stocker jusqu’à 999 fi chiers pour l’enregistrement vocal.
Vous pouvez effectuer jusqu’à 18 heures d’enregistrement (sur la base de 128 
Kbps, 1 Go).

REMARQUE
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Affi chage de l’horloge universelle
Vous pouvez vérifi er l’emplacement et les date et heure des principales 
villes à travers le monde en vous basant sur leurs fuseaux horaires 
respectifs.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Reportez-vous à la 
page 22.

AFFICHAGE DE L’HORLOGE UNIVERSELLE

1. Sélectionnez l’icône  située sur l’écran du 
menu principal.

2. Sélectionnez le fuseau horaire souhaité.
Vous pouvez affi cher les date et heure de la ville 
sélectionnée.
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Affi chage du calendrier
Vous pouvez vérifi er le calendrier.

Avant de démarrer - Vous devez tout d’abord régler l’horloge. Reportez-vous à la page 22.

AFFICHAGE DU CALENDRIER

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez le mois souhaité.
Poussez la touche [ ] vers le haut ou le bas pour 
sélectionner l’année souhaitée.
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Utilisation de la carte microSD
Le logement de la carte microSD intégrée vous permet de profi ter de vos 
photos et fi chiers musicaux sur un périphérique externe, tel qu’un téléphone 
mobile ou une caméra numérique.

Avant de démarrer - La carte microSD est proposée en option.

INSERTION DE LA CARTE MICROSD
Tenez la carte microSD en orientant la
puce vers le haut, puis introduisez-la 
complètement dans l’appareil. 

RETRAIT DE LA CARTE MICROSD
Appuyez légèrement sur l’extrémité de la 
carte microSD.

Ne retirez pas la carte microSD lors 
d’un transfert de fi chiers vers celle-ci ou 
en cours de lecture d’un fi chier stocké sur la carte.
Utilisez uniquement une carte mémoire microSD sur ce lecteur. (Si vous utilisez une 
carte mémoire autre que celle qui est spécifi ée, vous pourrez endommager celle-ci ou 
vous retrouver dans l’impossibilité de la retirer ; par ailleurs, le lecteur risque de ne pas la 
reconnaître.)
N’insérez pas la carte mémoire à l’envers.
Veillez à toujours sauvegarder vos données les plus importantes. Samsung ne sera pas 
tenu responsable de la perte de données occasionnée par l’utilisation d’une carte microSD 
endommagée.
Le lecteur prend en charge les cartes microSD d’une capacité allant jusqu à 4 Go.

ATTENTION
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LECTURE D’UN FICHIER CONTENU SUR LA CARTE MICROSD
Vous pouvez lire les photos, vidéos, textes et fi chiers musicaux de la carte microSD 
directement sur le lecteur.

1. Sélectionnez l’icône  située sur l’écran du menu 
principal.

2. Sélectionnez le dossier souhaité pour accéder à la liste 
de ses fi chiers.

3. Sélectionnez le fi chier souhaité.
La lecture du fi chier démarre.

Icône  : Fichier musical
Icône  : Fichier vidéo
Icône  : Fichier image
Icône  : Fichier texte

Vous ne pouvez pas lire un fi chier dont le format n’est pas pris en charge par le lecteur.

SUPPRESSION D’UN FICHIER CONTENU SUR LA CARTE 
MICROSD
Suivez les étapes 1 à 2 ci-dessus.

3. Sélectionnez le fi chier que vous souhaitez 
supprimer, puis appuyez sur la touche [ ].

4. Sélectionnez <Delete> (Supprimer)  <Yes> (Oui).
Le fi chier sélectionné est alors supprimé de la carte mémoire.

REMARQUE
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Dépannage
Si vous rencontrez un problème avec votre nouveau lecteur MP4, des 
solutions vous sont proposées dans cette liste. Si le problème persiste, 
contactez le service clientèle Samsung le plus proche.

PROBLÈME SOLUTION

L’appareil ne s’allume pas.
• L’appareil ne s’allumera pas si la batterie est 

entièrement déchargée. Rechargez la batterie et 
remettez l’appareil en marche.

• Appuyez sur le bouton de réinitialisation.

Les touches ne 
fonctionnent pas.

• Assurez-vous que la fonction Verrouillage destinée
à verrouiller toutes les opérations liées aux touches
n’est pas activée.

• Assurez-vous que vous appuyez sur la touche 
adéquate avant d’essayer.

• Appuyez sur la touche de réinitialisation.

L’écran ne s’allume pas.

• Il se peut que les données affi chées à l’écran ne 
soient pas visibles sous les rayons directs du soleil.

• Lorsque l’option <Display Off Time> (Délai de 
désactivation de l’écran) est sélectionnée dans 
<Settings> (Paramètres) <Display> (Affi cher), 
l’écran tactile s’éteint. Appuyez sur une touche
quelconque et vérifi ez si l’écran s’allume.

L’alimentation est coupée.

• L’alimentation se coupe automatiquement lorsque 
la batterie est entièrement déchargée. Rechargez la 
batterie.

• Si <Auto Power Off> (Extinction auto) est sélectionné 
dans <Settings> (Paramètres) <System> 
(Système), l’alimentation est coupée lorsque le lecteur 
est en mode Pause. Allumez le lecteur.
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PROBLÈME SOLUTION

L’autonomie de la batterie 
peut être différente de 
celle spécifi ée dans le 
manuel.

• L’autonomie de la batterie peut varier en fonction du 
mode son utilisé et du réglage de l’affi chage.

• La durée de vie de la batterie peut être réduite si 
vous exposez le lecteur à des températures basses 
ou élevées pendant des périodes prolongées.

Dysfonctionnement du 
programme EmoDio.

• Vérifi ez que votre ordinateur dispose de la 
confi guration requise.

La connexion à 
l’ordinateur est 
interrompue.

• Assurez-vous que le câble USB est branché 
correctement et essayez à nouveau.

• Exécutez la mise à jour de Windows sur votre 
ordinateur. Sélectionnez les mises à jour principales 
et l’ensemble des modifi cations provisoires, puis 
mettez à jour tous les composants. 
Redémarrez l’ordinateur et rebranchez l’appareil.

Le taux de transfert du 
fi chier est trop lent.

• Si vous avez formaté votre lecteur sous Windows 2000, 
le transfert de fi chier pourra être ralenti. Formatez votre 
lecteur sous Windows XP ou Vista et ressayez.

• Si plusieurs programmes sont ouverts sur votre 
ordinateur (dont <EmoDio>), le taux de transfert du 
fi chier sera ralenti. Quittez les programmes que vous 
n’utilisez pas et procédez à nouveau au transfert.

Le lecteur ne fonctionne 
pas.

• Vérifi ez que le fi chier disponible a bien été enregistré 
dans la mémoire.

• Assurez-vous que le fi chier musical n’est pas endommagé.
• Vérifi ez que la puissance de la batterie est suffi sante.

Les fi chiers ne se 
téléchargent pas.

• Vérifi ez que le câble USB est correctement branché. 
Rebranchez-le si nécessaire.

• Assurez-vous qu’il reste de l’espace disponible sur la 
mémoire.

• Appuyez sur le bouton de réinitialisation.



Dépannage _ 75

PROBLÈME SOLUTION
Des fi chiers ou des 
données manquent.

• Vérifi ez que le câble USB n’a pas été débranché 
durant le transfert du fi chier ou des données. Si 
tel est le cas, les fi chiers/données mais également 
l’appareil risquent d’être endommagés. Samsung ne 
saurait être tenu responsable des pertes de données.

Affi chage anormal de la 
durée de lecture.

• Vérifi ez que le fi chier est au format VBR 
(débit binaire variable).

Affi chage anormal du nom 
de fi chier.

• Allez dans <Settings> (Paramètres) 
<Language> (Langue) <Contents>
(Sommaire) depuis le menu principal, défi nissez 
la langue qui vous convient et mettez à jour la 
bibliothèque manuellement.

L’appareil est chaud. • Les phases de chargement peuvent générer de la 
chaleur. Cela n’a aucune incidence sur la durée de 
vie de l’appareil ou sur son fonctionnement.

Un message s’affi che 
pendant le visionnage 
d’une vidéo.

• Essayez à nouveau de télécharger le clip vidéo en 
passant par la fonction EmoDio.
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VIDEOS MUSIQUE

Son

Afficher

Mise à jour de la Bibliothèque

Langue(Language)

Heure

RADIO FM DIF. DONN. ENR VOCAL

CALENDRIER microSD NAVIGATEUR DE FICHIERS

IMAGES TEXTES

HORL. MOND.

PARAMETRES

Système

Annexe
ARBORESCENCE DES MENUS
Voici une présentation synthétique de l’organisation des menus et des fonctions dans
votre nouveau lecteur MP4.

Ecran de sélection du menu

Aller au mode pré-progr/ Aller au mode manuel

Ajouter aux présél. / Suppr. du prérégl.

Présélection auto

Réception FM

Région Radio

Ajouter signet

Accéd. à Signet

Supprimer signet

Luminosité

Affich. Désactivé

Effets Sonores

DNSe

Mode lecture

Ecran Lect mus.

Démarrer diaporama/
Arrêt diaporama

Vitesse diaporama

Zoom

Pivoter

Mode Affichage

Aller à la 1ère page

Ajouter signet

Accéd. à Signet

Supprimer signet
Type Visionneuse de texte

Sél. comme habillage
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CARACTÉRISTIQUES DU PRODUIT
Nom du modèle YP-CP3

Puissance nominale 5,0 V CC / 500 mA
Alimentation de la batterie 
intégrée 810 mAh / 3,7 V CC

Compatibilité

AUDIO : MPEG1/2/2.5 Couche3 (8 kbps ~ 320 kbps, 22 kHz 
~ 48 kHz), WMA (8 kbps ~320 kbps, 8 kHz ~48 
kHz) Ogg(Q0 ~Q10), FLAC (16 bits, 8 kHz ~ 48 
kHz), WAV (16 bits, 8 kHz ~ 48 kHz)

VIDÉO  : AVI/SVI : Vidéo MPEG-4 Profi l simple (640x480, 
800 kbps), MP3 Audio 
RM/RMVB : Vidéo Real Media (640x480, 800 kbps),
Real Audio 
WMV : Vidéo WMV9 (640x480, 500 kbps), Audio 
WMA

IMAGE : JPEG (Ligne de base, 7280x5760), BMP, PNG 
(960x720), GIF (900x900)

Sortie des écouteurs 20 mW/Ch. (basé sur 16 )
Bande de fréquences de la 
sortie 40 Hz~20 kHz

Rapport signal-bruit 89 dB avec fi ltre passe bas 20 kHz (sur la base de 1 KHz, 0 dB)
Nombre de dossiers/fi chiers 
pris en charge

Fichier : 5000 maxi.
Dossier : 5000 maxi.

Durée de lecture
Musique : 22 heures maxi. (MP3 128 kbps, Volume : 15, Mode 

Normal, LCD Off)
Vidéo :  4 heures maxi. (Luminosité 5, Volume : 15, Mode 

Normal)

Plage de températures de 
fonctionnement -5~35°C (23~95°F)

Etui Plastique
Poids 75 g
Dimensions (L x H x P) 100 X 52 X 11,1 mm
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Radio FM
Fréquence FM 87,5~108,0 MHz T.H.D. FM 1%

Rapport signal FM 55 dB Sensibilité FM 
utile 38dB

Le contenu de ce manuel est susceptible d’être modifi é en vue d’être amélioré sans 
notifi cation préalable.
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LICENSE
L’appareil qui se trouve avec ce manuel de l’utilisateur est fourni sous licence sous 
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée 
à une utilisation privée non commerciale par l’utilisateur fi nal pour les contenus sous 
licence.
Aucun droit n’est concédé pour une utilisation commerciale.
Cette licence ne couvre aucun produit autre que celui-ci et ne peut être étendue à 
un produit ou processus qui n’est pas sous licence selon la norme ISO/IEC 11172-3 
ou ISO/IEC 13818-3 utilisé ou vendu avec ce produit.
La licence couvre uniquement l’utilisation de ce produit pour encoder et/ou décoder 
des fi chiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3. Aucun droit 
n’est cédé sous cette licence pour des caractéristiques ou des fonctions du produit 
qui ne sont pas conformes à la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
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LES BONS GESTES DE MISE AU REBUT DE CE PRODUIT 
(DÉCHETS D’ÉQUIPEMENTS ÉLECTRIQUES ET ÉLECTRONIQUES)
(Applicable dans les pays de l’Union Européenne et dans d’autres pays européens 
pratiquant le tri sélectif) 
Ce symbole sur le produit, ses accessoires ou sa documentation 
indique que ni le produit, ni ses accessoires électroniques usagés 
(chargeur, casque audio, câble USB, etc.) ne peuvent être jetés 
avec les autres déchets ménagers. La mise au rebut incontrôlée 
des déchets présentant des risques environnementaux et de santé 
publique, veuillez séparer vos produits et accessoires usagés des 
autres déchets. Vous favoriserez ainsi le recyclage de la matière 
qui les compose dans le cadre d’un développement durable. Les 
particuliers sont invités à contacter le magasin leur ayant vendu 
le produit ou à se renseigner auprès des autorités locales pour 
connaître les procédures et les points de collecte de ces produits 
en vue de leur recyclage. Les entreprises et professionnels sont 
invités à contacter leurs fournisseurs et à consulter les conditions 
de leur contrat de vente. Ce produit et ses accessoires ne peuvent être jetés avec les 
autres déchets professionnels et commerciaux.

ELIMINATION DES BATTERIES DE CE PRODUIT
(Applicable aux pays de l’Union européenne et aux autres pays européens dans lesquels des 
systèmes de collecte sélective sont mis en place.)
Le symbole sur la batterie, le manuel ou l’emballage indique que 
les batteries de ce produit ne doivent pas être éliminées en fi n de 
vie avec les autres déchets ménagers. L’indication éventuelle des 
symboles chimiques Hg, Cd ou Pb signifi e que la batterie contient 
des quantités de mercure, de cadmium ou de plomb supérieures aux 
niveaux de référence stipulés dans la directive CE 2006/66. Si les 
batteries ne sont pas correctement éliminées, ces substances peuvent 
porter préjudice à la santé humaine ou à l’environnement. 
Afi n de protéger les ressources naturelles et d’encourager la 
réutilisation du matériel, veillez à séparer les batteries des autres 
types de déchets et à les recycler via votre système local de collecte gratuite des batteries.
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